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Warranty

The material contained in this docu-
ment is provided “as is,” and is sub-
ject to being changed, without notice, 
in future editions. Further, to the max-
imum extent permitted by applicable 
law, Agilent disclaims all warranties, 
either express or implied, with regard 
to this manual and any information 
contained herein, including but not 
limited to the implied warranties of 
merchantability and fitness for a par-
ticular purpose. Agilent shall not be 
liable for errors or for incidental or 
consequential damages in connection 
with the furnishing, use, or perfor-
mance of this document or of any 
information contained herein. Should 
Agilent and the user have a separate 
written agreement with warranty 
terms covering the material in this 
document that conflict with these 
terms, the warranty terms in the sep-
arate agreement shall control.

Technology Licenses 

The hardware and/or software described in 
this document are furnished under a 
license and may be used or copied only in 
accordance with the terms of such license.

Restricted Rights Legend

If software is for use in the performance of 
a U.S. Government prime contract or sub-
contract, Software is delivered and 
licensed as “Commercial computer soft-
ware” as defined in DFAR 252.227-7014 
(June 1995), or as a “commercial item” as 
defined in FAR 2.101(a) or as “Restricted 
computer software” as defined in FAR 
52.227-19 (June 1987) or any equivalent 
agency regulation or contract clause. Use, 
duplication or disclosure of Software is 
subject to Agilent Technologies’ standard 
commercial license terms, and non-DOD 
Departments and Agencies of the U.S. Gov-
ernment will receive no greater than 
Restricted Rights as defined in FAR 52.227-
19(c)(1-2) (June 1987). U.S. Government 
users will receive no greater than Limited 
Rights as defined in FAR 52.227-14 

(June1987) or DFAR 252.227-7015 (b)(2) 
(November 1995), as applicable in any 
technical data.

Safety Notices

 A WARNING notice denotes a 
hazard. It calls attention to an 
operating procedure, practice, or the 
like that, if not correctly performed or 
adhered to, could result in personal 
injury or death. Do not proceed 
beyond a WARNING notice until the 
indicated conditions are fully 
understood and met.

A CAUTION notice denotes a hazard. It 
calls attention to an operating procedure, 
practice, or the like that, if not correctly 
performed or adhered to, could result in 
damage to the product or loss of important 
data. Do not proceed beyond a CAUTION 
notice until the indicated conditions are 
fully understood and met.

,
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Preface
This guide provides safety information for the BioCel System.

This preface contains the following topics:

• “About this guide” on page vi

• “Accessing Automation Solutions user information” on page viii

• “Reporting problems” on page xi
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About this guide

Who should read this guide

This guide is for anyone who operates or services the BioCel 900, 1200, or 
1800 System.

What this guide covers

This guide describes the potential safety hazards on the BioCel 900, 1200, and 
1800 Systems and how to avoid them.

This guide does not provide instructions for using the BioCel System.

What is new in this guide

                                                        

Feature and description See

Emergency stop and interlock — Updated 
description of system responses and 
recovery procedure 

• “Stopping the system in an 
emergency” on page 6

• “Recovering from an 
emergency stop” on page 8

• “Recovering from tripped 
safety interlock” on page 10

Interlock key settings — Added 
description of NORMAL and BYPASS 
settings

“Safety interlock” on page 14

Interlocked doors — Added description of 
the new interlock key settings

“Interlocked doors” on page 15

Light Curtain — Added description based 
on the new interlock key settings

“Light Curtain” on page 15

Protective windows on docking tables — 
Updated description of system responses 
when window is removed

“Protective windows on docking 
tables” on page 16

System status indicators — Updated 
description of the system status 
indicators

“System status indicators” on 
page 16

Chemical hazards — Added list of 
chemicals compatible with the system 
surfaces

“Chemical and gas hazards” on 
page 33

BenchBot Robot — Added reference to 
the robot and associated user 
documentation

“System robot moving parts and 
pinch hazards” on page 21
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Related guides

Use this guide in conjunction with the following:

• Automation Control Unit User Guide. Describes the Automation Control 
Unit and provides the safety information, specifications and requirements, 
connection instructions, setup instructions, and troubleshooting 
information.

• BioCel System User Guide. Describes the BioCel System, the operation of 
the hardware components, and the use of software diagnostics.

• BioCel Environmental- Control System User Guide. Describes how to use 
the BioCel Environmental- Control System.

• BenchBot Robot user documentation. Describes the robot, safety 
information, operating instructions, maintenance procedures, and 
troubleshooting guidelines.

• Direct Drive Robot user documentation. Describes the robot, safety 
information, operating instructions, maintenance procedures, and 
troubleshooting guidelines.

• Lab automation software user documentation. Explains how to create 
protocols, and set task parameters for each device in the system.

• Automation Solutions device user documentation. Describe safety 
information, operation of the hardware, and the device diagnostics 
software.

Information about the 3- Axis Robot and Peak KiNEDx Robot are available in 
the BioCel System User Guide, Revision 01, August 2010.

If you also have third- party devices, see the relevant third- party device guides.

For site preparation and installation requirements, see the site- specific 
documentation provided by Automation Solutions. The site- specific documents 
address different system configurations and requirements. If you have 
questions, contact Automation Solutions Technical Support.

http://www.chem.agilent.com/Library/usermanuals/Public/G5500-90011_R01_BioCelUG_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5500-90011_R01_BioCelUG_EN.pdf
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Accessing Automation Solutions user information

About this topic

This topic describes the different formats of Automation Solutions user 
information and explains how to access the user information.

Where to find user information

The Automation Solutions user information is available in the following 
locations:

• Knowledge base. The help system that contains information about all of the 
Automation Solutions products is available from the Help menu within the 
VWorks software. 

• PDF files. The PDF files of the user guides are installed with the VWorks 
software and are on the software CD that is supplied with the product. A 
PDF viewer is required to open a user guide in PDF format. You can 
download a free PDF viewer from the internet. For information about using 
PDF documents, see the user documentation for the PDF viewer.

• Agilent Technologies website. You can search the online knowledge base or 
download the latest version of any PDF file from the Agilent Technologies 
website at www.agilent.com/lifesciences/automation.

Accessing safety information

Safety information for the Automation Solutions devices appears in the 
corresponding device user guide.

You can also search the knowledge base or the PDF files for safety information.

Using the knowledge base

Knowledge base topics are displayed using web browser software such as 
Microsoft Internet Explorer and Mozilla Firefox.

Note: If you want to use Internet Explorer to display the topics, you might 
have to allow local files to run active content (scripts and ActiveX controls). To 
do this, in Internet Explorer, open the Internet Options dialog box. Click the 
Advanced tab, locate the Security section, and select Allow active content to run in 
files on my computer.

To open the knowledge base, do one of the following:

• From within VWorks software, select Help > Knowledge Base or press F1.

• From the Windows desktop, select Start > All Programs > Agilent Technologies > 
VWorks > User Guides > Knowledge Base.

http://www.agilent.com/lifesciences/automation


ix

Accessing Automation Solutions user information

BioCel System Safety Guide

Opening the help topic for an area in the VWorks window

To access the context-sensitive help feature:

1 In the main window of the VWorks software, click the help button . 

The pointer changes to . Notice that the different icons or areas are 
highlighted as you move the pointer over them.

2 Click an icon or area of interest. The relevant topic or document opens. 
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Features in the Knowledge Base window

 

Item Feature

1 Navigation area. Consists of four tabs:

• Contents. Lists all the books and the table of contents of the 
books.

• Index. Displays the index entries of all of the books.

• Search. Allows you search the Knowledge Base (all products) 
using keywords. You can narrow the search by product.

• Favorites. Contains bookmarks you have created.

2 Navigation buttons. Enable you to navigate through the next or 
previous topics listed in the Contents tab.

3 Content area. Displays the selected online help topic.

4 Toolbar buttons. Enable you to print the topic or send documentation 
feedback by email.
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Reporting problems

Contacting Automation Solutions Technical Support 

Note: If you find a problem with the BioCel System, contact Automation 
Solutions Technical Support. For contact information, see Notices on the back 
of the title page. 

Note: You can also send a software bug report from within the VWorks 
software.

Reporting hardware problems

When contacting Agilent Technologies, make sure you have the serial number 
of the device ready.

Reporting software problems

When you contact Automation Solutions Technical Support, make sure you 
provide the following:

• Short description of the problem

• Software version number

• Error message text (or screen capture of the error message dialog box)

• Screen capture of the About VWorks software dialog box

• Relevant software files

To find the VWorks software version number:

In the VWorks software, select Help > About VWorks.

To find the Diagnostics software version number:

1 Open Diagnostics.

2 Read the version number on the title bar of the diagnostics window.

To send compressed protocol and associated files in VZP format:
In the VWorks software, select File > Export to export and compress the 
following files:

• Protocol file

• Device file (includes the device profile and teachpoint file)

• Labware definitions

• Liquid classes

• Pipette techniques

• Hit- picking files

• Plate map files

• Barcode files

• Error library

• Log files

• Form file (*.VWForm)
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Reporting user guide problems

If you find a problem with this user guide or have suggestions for 
improvement, send your comments using one of the following methods:

• Click the feedback button ( ) in the online help.

• Send an email to documentation.automation@agilent.com.
 

mailto:documentation.automation@agilent.com
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1
General safety information

This chapter describes the general safety information for the BioCel 
System (900, 1200, and 1800 models):

• “Before operating the BioCel System” on page 2

• “Intended product use” on page 2

• “Safety labels” on page 3

• “Safety and regulatory compliance” on page 4
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Before operating the BioCel System

The BioCel System is a laboratory automation platform that stores and moves 
labware for processing. The system is controlled using lab automation software 
such as the VWorks Automation Control software.

Before using the BioCel System, you must be aware of the potential hazards 
and understand how to avoid being exposed to them. In addition, make sure 
you are properly trained in:

• General laboratory safety

• The correct and safe operation of the BioCel System

• The correct and safe operation of other lab automation systems or 
components used in combination with the BioCel System

Intended product use

Agilent Technologies products must only be used in the manner described in 
the Agilent Technologies product user guides. Any other use may result in 
damage to the product or personal injury. Agilent Technologies is not 
responsible for any damages caused, in whole or in part, by improper use of 
the products, unauthorized alterations, adjustments or modifications to the 
products, failure to comply with procedures in Agilent Technologies product 
user guides, or use of the products in violation of applicable laws, rules or 
regulations. Except as otherwise expressly provided in Agilent Technologies 
product user guides, any alteration, adjustment or modification to the products 
will void the product warranty and may invalidate the safety compliance 
certification.

The BioCel System is not intended or approved for diagnosis of disease in 
humans or animals. You assume full responsibility for obtaining any regulatory 
approvals required for such use and assume all liability in connection 
therewith.

                                                         

WARNING  Do not remove the BioCel System exterior covers or otherwise disassemble 
the system or integrated devices. Doing so can expose you to hazards that could cause 
serious injury and damage the BioCel System.

WARNING  Using controls, making adjustments, or performing procedures other than 
those specified in the user guide can expose you to moving parts, hazardous voltage, high-
pressure gases, and laser radiation. Exposure to these hazards can cause severe injury.
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Safety labels

Warnings in the user documentation or on the device must be observed during 
all phases of operation, service, and repair of this device. Failure to comply 
with these precautions violates safety standards of design and the intended use 
of the product. Agilent Technologies assumes no liability for the customer’s 
failure to comply with these requirements.

The following table lists the common symbols you might find on the system or 
device. The symbol on the label indicates the risk of danger. A description of 
the warning and information that will help you avoid the safety hazard are 
provided in this guide.

Symbol Description

Indicates that you must read the accompanying 
instructions (for example, the safety guide) for more 
information before proceeding.

Indicates hazardous voltages.

Indicates pinch, crush, or cut hazard.

Indicates laser hazard.

Indicates hot surface hazard.

Indicates protective conductor terminal, which is bonded 
to conductive parts of an equipment for protection 
against electric shock in case of a fault and is intended 
to be connected to an external protective earthing 
system.

Indicates frame or chassis terminal, which is bonded to 
conductive parts of an equipment for safety purposes.

Indicates that you must not discard this electrical/
electronic product in domestic household waste.
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Safety and regulatory compliance

The BioCel System complies with the applicable EU Directives and bears the 
CE mark. See the Declaration of Conformity for details. The BioCel System is 
designed to comply with the regulations and standards listed in the following 
table. 

Electromagnetic compatibility
If the BioCel System causes interference with radio or television reception, 
which can be determined by turning the device off and on, try one or more of 
the following measures:

• Relocate the radio or television antenna.

• Move the device away from the radio or television.

• Plug the device into a different electrical outlet, so that the device and the 
radio or television are on separate electrical circuits.

• Make sure that all peripheral devices are also certified.

• Make sure that appropriate cables are used to connect the device to 
peripheral equipment.

• Consult your equipment dealer, Agilent Technologies, or an experienced 
technician for assistance.

Changes or modifications not expressly approved by Agilent Technologies could 
void the user's authority to operate the equipment.

Sound emission declaration
Sound pressure: Lp < 70 dB according to EN 27779:1991.

Schalldruckpegel: Lp < 70 dB nach EN 27779:1991.
 

Regulatory Compliance Standard

EMC

European Union EMC Directive 2004/108/EC

IEC 61326- 1:2005 / EN 61326- 1:2006

Canada ICES/NMB- 001:2004

Australia/New Zealand AS/NZS CISPR 11:2004

Safety

European Union Machinery Directive 2006/42/EC

Low Voltage Directive 2006/95/EC

IEC 61010- 1:2001 / EN61010- 1:2001

Canada CAN/CSA- C22.2 No. 61010- 1- 04

USA ANSI/UL 61010- 1:2004
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2
Emergency stop

This chapter explains how to stop the BioCel System in an 
emergency and how to recover the system after an emergency stop. 
This chapter contains the following topics:

• “Stopping the system in an emergency” on page 6

• “Tripping the safety interlock” on page 7

• “Recovering from an emergency stop” on page 8

• “Recovering from tripped safety interlock” on page 10
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Stopping the system in an emergency

Procedure

In an emergency, press the red button on the emergency- stop pendant. The 
BioCel System robot and integrated devices stop immediately.

Figure Pressing the red button on the emergency-stop pendant

Note: The emergency stop mechanism is not affected by the INTERLOCK key 
setting. Pressing the red button on the emergency- stop pendant will stop 
robots and devices in the system even if the INTERLOCK key is set at BYPASS.

For a description of the interlock key settings, see “Safety features” on page 13 
and the Automation Control Unit User Guide.

System response

The emergency stop does the following:

• Stops all robots and devices in the system.

• Stops the air supply to the devices.

• Turns on the following light pattern in the multicolor status light: flashing 
red light only.

• Turns on the red E_STOP light on the Automation Control Unit and 
generates robot and device errors.

• Turns on the blue blinking RESET light on the Automation Control Unit.

For recovery instructions, see “Recovering from an emergency stop” on page 8.
                                                        

CAUTION  Do not use the emergency stop to pause a protocol. Using the emergency stop 
might affect the integrity of the interrupted protocol. Instead, use the pause button in the lab 
automation software to perform routine stops. For instructions, see the lab automation 
software user documentation.
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Tripping the safety interlock

About this topic

This topic explains the following:

• How the safety interlock is tripped

• System response—INTERLOCK key is set at NORMAL

• System response—INTERLOCK key is set at BYPASS

How the safety interlock is tripped

The safety interlock is tripped when you:

• Open a system door

• Interrupt the Light Curtain

IMPORTANT To prevent inert gases from displacing air and causing 
suffocation, the system doors of an inert environment hood remain locked until 
all of the gas is safely purged. For details, see “Chemical and gas hazards” on 
page 33.

System response—INTERLOCK key is set at NORMAL

If the INTERLOCK key is set at NORMAL, tripping the safety interlock does the 
following:

• Stops all robots and integrated devices that have an emergency- stop 
circuit.

• Allows remaining integrated devices to finish the current task, and then 
pauses the devices.

• Turns on the audible alarm (if it is configured to turn on).

• Turns on the following light pattern in the multicolor status light: flashing 
red light only.

• Turns on the red DOORS light or the red LIGHT CURTAIN light on the 
Automation Control Unit.

• Turns on the blue blinking RESET light on the Automation Control Unit.

• Displays the Scheduler Paused dialog box in the lab automation software.

Note: The air supply is not affected by the tripped interlock.

CAUTION  Do not open a system door or interrupt a Light Curtain to perform a routine stop. 
The door or Light Curtain interlock is designed to be a safety backup system. Using the 
interlock to stop the system might affect the integrity of the interrupted protocol. Instead, use 
the pause button in the lab automation software to perform routine stops. For instructions, see 
the lab automation software user documentation.

WARNING  After you open a system door or interrupt the Light Curtain, some integrated 
devices might continue to move until they have finished the current task. Wait until all 
devices are paused before entering the system.
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For a description of the NORMAL interlock key setting, see “Safety features” on 
page 13 and the Automation Control Unit User Guide. For recovery 
instructions, see “Recovering from tripped safety interlock” on page 10. 

System response—INTERLOCK key is set at BYPASS

If the INTERLOCK key is set at BYPASS, the Agilent robots and devices that 
have an emergency- stop circuit move at a significantly slower speed. Tripping 
the safety interlock has no effect on the system. All robots and devices 
continue to move and operate at the reduced speed.

The multicolor status light displays a flashing yellow light. In addition, the blue 
light on the RESET button remains solid.

For a description of the BYPASS interlock key setting, see “Safety features” on 
page 13 and Automation Control Unit User Guide.

Recovering from an emergency stop

About this topic

After pressing the red button on the emergency- stop pendant, you must 
restore the system for normal operation.

IMPORTANT You cannot resume or recover a protocol run after pressing the 
red button on the emergency- stop pendant. You will need to rerun the protocol 
after restoring the system for normal operation.

Procedure

Before you restore the system, make sure you remove labware at teachpoints 
or other locations.

To restore the BioCel System after an emergency stop:

1 At the emergency- stop pendant, turn the red button clockwise. The spring-
loaded button pops up.

2 If the BioCel System has the Light Curtain, remove any obstacle that is 
interrupting the Light Curtain.

3 If the BioCel System has system doors, close the doors.

WARNING  Access to and use of the interlock key should be controlled. To avoid 
possible injury, the Interlock Bypass setting should be used only by personnel trained to 
teach robots and devices in the system or workstation. The interlock key should be 
removed from the BioCel System when the switch is set at Normal and you are not 
teaching the robots and devices.
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4 At the Automation Control Unit, press the RESET button. The blue light 
stops blinking and becomes solid.

5 In each of the device dialog boxes opened in the software, select one of the 
following commands to restore the device for normal operation. For 
example, you might need to use the device diagnostics software to release 
labware, replace the lid on a labware, home the robot, or verify the device 
teachpoint.

6 If there is labware in the robot gripper, use diagnostic commands to move 
it back to the pickup location. To do this:

a Determine the location from which the labware was picked up.

b In the Robot Error dialog box, click Diagnostics.

c Use commands to place the labware at the pickup location.

7 Click Abort Process in the Stop dialog box.

8 Exit and restart the lab automation software. Re- establish communication 
with the devices by initializing the devices.

                                                        

NON-SWITCHED
AC

SWITCHED
AC

ACU POWER
5/24 VDC

DOORS

F15A, 600 VAC
CLASS CC

POWER

5 VDC 24 VDC
NORMAL BYPASS

INTERLOCK

RESET

DC STATUS

LIGHT
CURTAIN E-STOP

Selection Description

Diagnostics Opens the device diagnostics dialog box.

Note: This selection is available only when you are in 
the middle of a protocol run and not while you are 
already in the device diagnostics software.

Retry Attempts to restart the current command or task in 
the run.

Ignore and 
continue

Ignores the current command or task and continues 
to the next command or task in the protocol 
sequence.

Abort Aborts the current command or task in the run. 
Select Abort if you have determined that the protocol 
run is not recoverable.
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Recovering from tripped safety interlock

If you opened a system door or interrupted the Light Curtain during a 
protocol run, the Scheduler Paused dialog box opens in the lab automation 
software.

To resume the run or recover the system after opening the system door or interrupting the 
Light Curtain:

1 In the lab automation software, click one of the following in the Scheduler 
Paused dialog box:

Note: If you have a Centrifuge Loader, click Diagnostics to open Centrifuge 
Loader Diagnostics, and then re- initialize the device to re- establish 
communication with it.

                                                        

Selection Description

Bypass interlock Bypasses the interlock so that you can enter the 
system. For detailed instructions, see the lab 
automation software user guide, such as the VWorks 
Automation Control User Guide.

Bypass interlock is only available if your system is 
installed with an Automation Control Unit and the 
protocol is not running in simulation mode.

Note: If you click Bypass interlock, you will not be 
able to open any diagnostics dialog box.

When you are finished, close the system door or 
remove obstacles from the Light Curtain and select 
one of the other commands in the Schedule Paused 
dialog box.

Continue Ignores the current command or task and continues 
to the next command or task in the protocol 
sequence.

Diagnostics Allows you to select the device and opens the device 
diagnostics dialog box.

Note: This selection is available only when you are in 
the middle of a protocol run and not while you are 
already in the device diagnostics software.

Abort process Aborts the current command or task in the run. 
Select Abort if you have determined that the protocol 
run is not recoverable.
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2 In the Robot Error dialog box, click one of the following:

3 If a Vertical Pipetting Station was in motion when the system door was 
opened or the Light Curtain was interrupted, select a command in the 
Vertical Pipetting Station Error dialog box. For instructions, see the 
Vertical Pipetting Station User Guide.

Selection Description

Diagnostics Opens the device diagnostics dialog box.

Note: This selection is available only when you are in 
the middle of a protocol run and not while you are 
already in the device diagnostics software.

Retry Attempts to restart the current command or task in 
the run.

Ignore and 
continue

Ignores the current command or task and continues 
to the next command or task in the protocol 
sequence.

Abort Aborts the current command or task in the run. 
Select Abort if you have determined that the protocol 
run is not recoverable.



Emergency stop
Recovering from tripped safety interlock

12 BioCel System Safety Guide



13

BioCel System
Safety Guide

Agilent Technologies

3
Safety features

This chapter describes the safety features in the BioCel System:

• “Safety interlock” on page 14

• “Emergency- stop pendants” on page 14

• “Interlocked doors” on page 15

• “Light Curtain” on page 15

• “Protective windows on docking tables” on page 16

• “System status indicators” on page 16

It is the responsibility of every operator to use the built- in BioCel 
System safety features and follow warnings and safety labels. If you 
have questions about the safety features, contact Automation 
Solutions Technical Support.

WARNING  Do not disable or change the BioCel System safety features. Doing 
so might invalidate the safety compliance and lead to personal injury or 
equipment damage. In Europe, any changes might invalidate Agilent's Declaration 
of Conformity and require the person making the changes to assume 
responsibility as manufacturer of the system or workstation according to the 
Machinery Directive.
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Safety interlock 

The BioCel System is equipped with safety interlock features that are designed 
to protect you from moving- part hazards while the system is in operation. The 
safety interlock circuit must be closed for the system to operate.

Two interlock key settings are available:

• NORMAL. The interlock is armed. Opening a system door or interrupting 
the Light Curtain opens the interlock circuit, thus stopping the robots and 
devices that are on the circuit. Devices that are not on the circuit will 
finish the current task before pausing. Under normal operating conditions, 
the INTERLOCK key should be set at NORMAL.

• BYPASS. The interlock is muted (or bypassed). Agilent robots and devices 
that have an emergency- stop circuit will move at a significantly reduced 
speed. Opening a system door or interrupting the Light Curtain does not 
open the safety interlock circuit, so the robots and devices will continue to 
move. Use the BYPASS key setting if you need to work inside of the system 
or workstation while teaching robots and devices.

For a detailed description of the two interlock modes, see the Automation 
Control Unit User Guide.

Note: The INTERLOCK key setting does not affect the emergency stop 
mechanism. Pressing the red button on the emergency- stop pendant will stop 
robots and devices in the system even if the INTERLOCK key is set at BYPASS.

Emergency-stop pendants

The emergency- stop pendants are single- button devices that enable the 
operator to stop the system quickly during an emergency. The pendants are 
part of the safety interlock circuit that must be closed for the system to 
operate. Pressing the red button on one of the pendants opens the safety 
interlock circuit and stops the robot and devices.

For more information about stopping the system during an emergency, see 
“Stopping the system in an emergency” on page 6.

WARNING  Access to and use of the interlock key should be controlled. To avoid 
possible injury, the Interlock Bypass setting should be used only by personnel trained to 
teach robots and devices in the system. The interlock key should be removed from the 
BioCel System when the switch is set at Normal and you are not teaching the robots and 
devices.
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Interlocked doors

Polycarbonate or glass doors surrounding the BioCel 1800 System and BioCel 
1200 System prevent the operator from entering the workspace. An interlock 
sensor is installed at each system door to detect whether the door is open or 
closed. Under normal operating conditions, opening a system door stops the 
motion of the robot and devices that are connected to the emergency- stop 
circuit. Devices that are not connected to the emergency- stop circuit will finish 
the current task before pausing.

Light Curtain

As part of the safety interlock circuit, the Light Curtain works in a similar 
manner to the interlocked doors. Lightposts project and reflect light beams 
around the BioCel 900 System. Under normal operating conditions, interrupting 
the Light Curtain stops the motion of the robot and devices that are connected 
to the emergency- stop circuit. Devices that are not connected to the 
emergency- stop circuit will finish the current task before pausing.

AC
SWITCHED

AC
ACU POWER

5/24 VDC

DOORS

F15A, 600 VAC

5 VDC
24 VDC NORMAL BYPASS

INTERLOCK

RESET

DC STATUS

LIGHT
CURTAIN E-STOP

I   ON

O
  
 O

F
F

00
27

9
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Protective windows on docking tables

Docking tables permit you to add or remove devices in the BioCel System to 
accommodate different applications. Some docking tables have protective 
windows that are connected to the safety interlock circuit and function like the 
BioCel System doors. Under normal operating conditions, opening a protective 
window during the run stops the motion of the robot and devices that are 
connected to the emergency- stop circuit. Devices that are not connected to the 
emergency- stop circuit will finish the current task before pausing.

Instead of connecting to the safety interlock circuit, some protective windows 
have tooled locks (require the use of a hex wrench) to prevent operators from 
entering the system while the system is in motion. The protective window 
should be locked during system operation.

System status indicators

Status lights and audible alarms enable you to monitor the current status of 
the system from a distance.

Multicolor status lights are optional in all BioCel System models. An audible 
alarm device is supplied with all BioCel System models.

For information about the system status lights and audible alarm device, see 
the BioCel System User Guide.

WARNING  BioCel System administrators. If you bypass the safety interlock system 
and enter the system, you can be hit or pinched by the robot or devices. Be sure to wear 
protective eyewear when entering the system. 

WARNING  BioCel System administrators. Only fully trained BioCel System 
administrators should be permitted to unlock and open the protective windows. Unlock or 
open the windows only after you have set the interlock key switch to Bypass. Be sure to 
wear protective eyewear when entering the system. Exit the BioCel System and close the 
windows before setting the interlock key switch to Normal. Keep out of the BioCel System 
while the interlock is set at Normal.

WARNING Although docking tables permit flexible system configurations, non-
authorized configuration modifications can result in exposure to new safety hazards and 
may invalidate safety compliance certification. Contact Automation Solutions for 
assistance with system modifications and safety consultation.
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4
Potential hazards

This chapter contains the following topics:

• “Overview of potential hazards” on page 18

• “Mechanical hazards” on page 19

• “Electrical hazards” on page 31

• “Radiation hazards” on page 32

• “Chemical and gas hazards” on page 33

• “Heat hazards” on page 36
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Overview of potential hazards

The following table lists potential injury hazards for the Automation Solutions 
devices and accessories that can be part of a BioCel System. For information 
on how to avoid a hazard, see the corresponding topic in the following 
sections. General chemical hazards are discussed briefly in “Chemical and gas 
hazards” on page 33.

* With optional barcode reader only. 
** 3- Axis Robot and Staubli Robot with the optional barcode reader only.

Device or 
accessory

Mechanical: 
moving 
parts

Mechanical: 
sharp 
edges

Electrical: 
hazardous 
voltage

Radiation: 
lasers

Gas: 
high-
pressure 

Gas: 
oxygen- 
displacing

Heat 
hazards

Barcode Reader X

Inert 
Environment 
Hood

X X X

Liquid handler: 
Bravo Platform

X X X*

Liquid handler: 
Vertical 
Pipetting 
Station

X X X* X

Plate Hub 
Carousel

X X

PlateLoc Sealer X X X X X

Seal Piercer X X X X

Pump Module X X

Robot, system X X X**

G5404B 
Microplate 
Labeler

X X X* X X

Microplate 
Centrifuge

X X

Microplate 
Centrifuge with 
Loader

X X

Labware 
Stacker

X X

Labware Racks X
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Mechanical hazards

The BioCel System contains various devices with moving parts and pinch 
hazards. Certain parts have sharp edges. This topic describes the potential 
hazards and how to avoid them:

• System flip- up door injury hazards

• System robot moving parts and pinch hazards

• Plate Hub Carousel moving parts and pinch hazards

• PlateLoc Sealer moving parts, pinch, crush, or cut hazards

• Pump Module moving parts and pinch hazards

• Seal Piercer moving parts, pinch, and pierce hazards

• Microplate Labeler moving parts and pinch hazard

• Vertical Pipetting Station moving parts and pinch hazards

• Centrifuge and Centrifuge Loader moving parts and pinch hazards

• Stacker and Labware Racks hazards

System flip-up door injury hazards

If you have a BioCel System that has flip- up doors, be aware of the following 
hazards.

Two gas struts are used to raise and lower each flip- up door. The struts (2) 
are attached to the flip- up door (1) and the frame (3).

Figure Gas strut attached to the flip-up door and frame

                                                        

WARNING  Keep your fingers, hair, clothing, and jewelry away from the BioCel System 
while the system is in motion. The BioCel System has moving parts that can injure you if 
you deviate from the procedures given in the user guides. 

00
00

7

1

2

3
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Retention clips prevent the struts from becoming detached from the door and 
frame. A retention clip (1) is installed at each end of the strut.

Figure Retention clip at the upper and lower end of the gas strut

                                                        

00
00

7

1

WARNING  Before operating the system, make sure retention clips are present at the 
upper and lower ends of each gas strut. Missing clips can cause the struts to detach from 
either the door or frame, causing the door to fall when opened. If one or more clips are 
missing, contact Automation Solutions Technical Support immediately. Do not operate the 
system until the clips are installed.

WARNING  Opened overhead doors are approximately 188 cm (6 ft 2 in) above the floor. 
To avoid injury, be aware of the door height and position at all times when working around 
the BioCel System.

00
00

7

6 feet 2 in.
188 cm
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System robot moving parts and pinch hazards

The BioCel System uses one of the following robots:

• BenchBot Robot

• Direct Drive Robot

• 3- Axis Robot

• KiNEDx Robot

• Staubli Robot

If the BioCel System uses a BenchBot Robot, see the BenchBot Robot Safety 
and Installation Guide for safety information.

If the BioCel System uses a Direct Drive Robot, see the Direct Drive Robot 
Safety Guide for safety information.

If the BioCel System uses a Staubli Robot, see the Staubli Robot user 
documentation for safety information.

3-Axis Robot
The 3- Axis Robot can move about its three joints and along its vertical axis, as 
the following figure shows.

Figure 3-Axis Robot joints (top view) and vertical axis (side view)

WARNING BioCel System administrators. If you override the safety interlock system, 
you can be hit or pinched by the robot arm while it is moving. Be sure to wear protective 
eyewear when entering the system. Keep out of the BioCel System while the system is in 
motion. Serious injury may be possible under some circumstances. 

Item Joint or axis Description of robot movement

1 Waist Robot arm rotates 360° about the waist.

2 Lower elbow Robot lower and middle forearms rotate about the 
lower elbow.

3 Upper elbow Robot middle and upper forearms rotate about the 
upper elbow.

4 Mast Robot arm moves up and down along the mast.

4

3
2

1
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The following figure shows the robot’s maximum radial and vertical reach. The 
radial reach includes a typical microplate held in landscape orientation.

Figure 3-Axis Robot radial (top view) and vertical reach (side view)

The tapered robot grippers are designed to prevent puncture or other injuries. 
However, you can be injured if you obstruct the robot while it is in motion.

Figure Spacing at the back of the 3-Axis Robot grippers (top view)

WARNING BioCel System administrators. Do not try to predict the robot’s movements 
and reach into the robot’s travel space while it is in operation.

A
1

66 cm

45 cm

WARNING  BioCel System administrators. Keep clear of the robot and its grippers 
while it is in motion.

WARNING  BioCel System administrators. Do not insert your fingers in the spacing at 
the back of the robot grippers while the robot motors are on. The grippers can pinch or 
injure your fingers when it closes.
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KiNEDx Robot
The KiNEDx Robot has six axes of motion, as the following figure shows.

Figure KiNEDx Robot axes of motion (top view and side view)

The following diagram shows the robot’s maximum radial and vertical reach. 
The radial reach includes a typical microplate held in landscape orientation.

Item Axis Description of robot movement

1 Shoulder Robot forearm (upper segment) rotates about the 
shoulder joint.

2 Upper elbow Robot forearm (middle segment) rotates about the 
upper elbow joint.

3 Lower elbow Robot forearm (lower segment) rotates about the 
lower elbow joint.

4 Wrist Robot hand rotates about the wrist.

5 Waist Robot arm rotates 360° about the waist.

6 Mast Robot arm moves up and down along the mast.

1

4

3

2

6

5

WARNING BioCel System administrators. The robot does not always move in a straight 
line between teachpoints. Do not try to predict the robot’s movements and reach into the 
robot’s travel space while it is in operation.
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Figure KiNEDx Robot radial (top view) and vertical reach (side view)

The tapered robot grippers and the robot’s low inertia are designed to prevent 
puncture or other injuries. However, you can be injured if you obstruct the 
robot while it is in motion.

Figure Spacing at the back of the KiNEDx Robot grippers (top view)

A
1

56 cm

47 cm

12 cm

WARNING  BioCel System administrators. Keep clear of the robot and its grippers 
while it is in motion.

WARNING  BioCel System administrators. Do not insert your fingers in the spacing at 
the back of the robot grippers while the robot motors are on. The grippers can pinch or 
injure your fingers when it closes.



25

Potential hazards
Mechanical hazards

BioCel System Safety Guide

Plate Hub Carousel moving parts and pinch hazards

The Plate Hub Carousel rotates to the left and the right to make the 
microplates accessible to the system robot.

Figure Plate Hub Carousel moving parts

                                                        

WARNING  The Plate Hub Carousel is an extremely high-powered automated device 
that can rotate suddenly with great force. You cannot anticipate the movement of the 
device with certainty, because the software determines when to move the device to 
achieve the highest throughput. The labware racks on the device have thin edges, and the 
forceful movement can cause severe injuries.

WARNING  All operators. Always close the system doors and make sure the interlock 
is armed before initializing the Plate Hub Carousel. 

WARNING  BioCel System administrators. If you bypass the safety interlock system, be 
sure to keep out of the BioCel System while the Plate Hub Carousel initializes or when it is 
powered on. Be sure to wear protective eyewear when entering the system. Do not touch 
any of the moving parts or attempt to move labware while the device is in operation. 

00247
BioCel
Plate hub

00247
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PlateLoc Sealer moving parts, pinch, crush, or cut hazards

A warning label on the front panel warns you of the potential moving parts, 
pinch, pierce, and cut hazards. The following figure shows the location of the 
label.

Figure PlateLoc Sealer pinch, crush, or cut hazard label

Pump Module moving parts and pinch hazards

In the following figure, the safety labels are visible under the open cover on 
the bottom pump head.

Figure Pump Module with open pump head cover

                                                        

WARNING  Do not disable the device door sensor or attempt to access the interior of 
the device through any other openings. Exposure to the moving parts, such as the heated 
metal plate (hot plate) or the seal-cutting blade can cause severe injuries. 

WARNING  Ensure that the Pump Module is turned off before lifting the flip-top cover 
on a pump head. Keep the cover closed while the pump is running. 

WARNING Pinch hazard! If a cover on a pump head is open, do not allow fingers to 
contact moving parts. 

00306

Pump Module
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Seal Piercer moving parts, pinch, and pierce hazards

If the Seal Piercer pin plate is in the lowered position, an action can cause it 
to move upwards with considerable force, resulting in injury if your hand is 
inside the device. 

Figure Seal Piercer with lowered pin plate

Microplate Labeler moving parts and pinch hazard

The Microplate Labeler contains the following moving parts.

Figure Microplate Labeler moving parts

WARNING  BioCel System administrators. Do not reach into the Seal Piercer when the 
power and air are turned on and the device is connected to the AC outlet. Exposure to the 
moving parts can cause severe injuries.

00061
PlatePierce
Front open

00
06

1

1                     2                                 3
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Vertical Pipetting Station moving parts and pinch hazards

Item Description

1 Plate stage. Automatically rotates side to side during labeling to 
present the long and short sides of a microplate to the applicator 
head.

2 Applicator head. Automatically rotates between the printer and the 
plate stage to apply the barcode labels.

3 Printer. Contains various parts that move automatically during a 
print run. Keep the cover closed while the device is operating. 

WARNING  Pinch hazard. Do not reach between the plate stage and applicator head or 
between the applicator head and the printer while the device is on. 

WARNING Pinch hazard. Use care when closing the printer cover. Keep clear of the 
cover hinges and do not reach into the swivel range of the cover.

WARNING BioCel System administrators. If you operate the printer with the cover open 
or with the cover removed, ensure that you keep clear of the exposed rotating parts.

WARNING All operators. When you initialize the Vertical Pipetting Station, the pipette 
head and shelves can move. Always close the system doors and make sure the interlock is 
armed before initializing the Vertical Pipetting Station.

WARNING BioCel System administrators. If you bypass the safety interlock system, be 
sure to keep out of the BioCel System while the Vertical Pipetting Station initializes or 
when it is in motion. Be sure to wear protective eyewear when entering the system. Do not 
touch any of the moving parts or attempt to move labware while the Vertical Pipetting 
Station is in operation. The device could pinch, pierce, or bruise you.
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Figure Vertical Pipetting Station with shaded areas showing pinch point and pierce hazards 

Centrifuge and Centrifuge Loader moving parts and pinch hazards

Figure Centrifuge with Centrifuge Loader moving parts

WARNING BioCel System administrators. If you bypass the safety interlock system, be 
sure to keep out of the BioCel System while the Centrifuge or Centrifuge Loader is in 
operation. Do not attempt to touch any of the moving parts or remove microplates while the 
Centrifuge or Centrifuge Loader is in operation. If the door of the device is functioning 
properly, it is not possible to touch the rotor while it is in motion. However, the door can 
cause possible pinching, piercing or bruising when it closes.

WARNING Do not run the Centrifuge or Centrifuge Loader if any components or 
accessories are damaged or have been modified in any manner not authorized by Agilent 
Technologies. Discontinue use if the device vibrates or emits noise above normal levels.

WARNING  Do not operate the Centrifuge or Centrifuge Loader if foreign objects or 
liquids are trapped within the chamber.

00090
VSpin
access
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Stacker and Labware Racks hazards

Figure Stacker (1) moving parts and (2) pinch hazard

                                                        

WARNING All operators. The Stacker microplate stage can move when you turn on the 
device and when the software is establishing communication with the device. Always 
close the system doors and make sure the interlock is armed before initializing the 
Stacker.

WARNING BioCel System administrators. If you bypass the safety interlock system, be 
sure to keep out of the BioCel System while the Stacker is in operation. The moving 
microplate stage can catch your hands, clothing, jewelry, and so on in the mechanisms, 
causing injury.

WARNING Pinch hazard! Keep your fingers out of the path of the Labware Racks when 
you mount the Racks on the Stacker. 

00029
vstack
vstack separated

00029

(1) (2)
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Figure Correct handling to avoid sharp surfaces on the Labware Racks (1) standard and (2) 
front load or top load

Electrical hazards

Hazardous-voltage electronics

Hazardous- voltage electronics can be found within the integrated devices on 
BioCel System. Hazardous- voltage electronics can also be found within the 
system, power panel, and robot.

Hazardous- voltage electronics can also be found in the computer. See the 
computer manufacturer documentation for the hazard warnings. Make sure you 
follow the instructions on the safe operation of the computer.

 

WARNING Use the rack handle to carry the Labware Racks. Do not hold a rack by the 
interior edges. The interior edges can have sharp surfaces that can cause cuts if handled 
improperly. 

1 2

WARNING  Do not try to gain access to the interior of any of the system devices. Do not 
remove a device’s panels for any reason. Exposure to the interior electronics of a device 
can cause severe injury.

WARNING Ensure that the power cords are in good condition and are not frayed. Use of 
frayed or damaged power cords can cause injury. Use of incorrect power cords can cause 
damage to the device.
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About the Automation Control Unit

See the Automation Control Unit User Guide for detailed safety information.

Radiation hazards

Automation Solutions lasers

Your BioCel System can contain one or more lasers used to read barcodes. One 
barcode reader, attached underneath the robot arm, is used to read 
microplates as they are picked up. Other barcode readers might be included on 
your system, attached to platepads, Microplate Labeler printers, Vertical 
Pipetting Station shelves, or the Bravo Platform.

The laser beam will not harm your skin, so there is no danger in exposing 
your arms or hands to the beam. However, you could damage your eyes if you 
stare directly into the beam.

Barcode readers emit light for up to 0.5 seconds only when taking a reading. 
The potential hazard is present only during protocol runs. When a microplate 
is being read, the beam should not pass beyond the microplate. Operating the 
BioCel System without microplates, and with the system doors open, increases 
the risk of exposure.

All readers point downwards to minimize the potential exposure at eye level. 
The robot barcode reader represents the greatest potential exposure because of 
its height above the table.

Third-party lasers

Your BioCel System might also contain lasers built into other third- party 
devices, such as Zeiss Multimode readers and Liconic incubators. For 
information about laser safety for third- party devices, see the relevant device’s 
documentation.

WARNING  Do not remove the Automation Control Unit covers or disassemble the unit. 
Doing so can expose you to hazards that could cause serious injury and damage the BioCel 
System.

WARNING The BioCel barcode readers use class II lasers. Do not look directly at the 
laser beam. Looking directly at the laser beam can result in serious eye injury.

WARNING Do not disassemble barcode reader sensor heads. Laser emission from the 
reader is not automatically stopped if the sensor head is disassembled. 

WARNING Unless you are following a procedure in a Agilent Technologies user guide, 
do not touch the white test button on the side of the sensor head of an auxiliary barcode 
reader. The white test button turns on the laser and can result in unsafe exposure to the 
beam.
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Chemical and gas hazards

Chemical hazards

General guidelines
Some chemicals used when working with the BioCel System can be hazardous. 
Make sure you:

• Follow standard laboratory procedures and cautions when working with 
chemicals.

• Follow your local, state, and federal safety regulations when using and 
disposing of the chemicals.

Compatible chemicals
The BioCel System surfaces are designed to be compatible with small volumes 
of aqueous solutions, common biological buffers, solvents, and common 
reducing agents.

The following chemicals were tested for brief exposures outside the liquid-
handling channels:

• Water (deionized, ultrapure type 1)

• Dimethyl sulfoxide (100%)

• Strong acid, such as hydrochloric acid (100 mM HCl) pH 2- 3

• Strong base (HPO4 or sodium hydroxide, 100 mM) pH 12- 13

• Ethanol (95% alcohol)

• Methanol (95% alcohol)

• Acetonitrile (100%)

• Chloroform (100%)

• Hydrogen peroxide (35%)                            

• Tetrahydrofuran

• Dichlormethan

• Toluene

• Acetone

Agilent Technologies recommends that you employ an Environmental Health 
and Safety professional on site to confirm the compatibility of other chemicals.
 

Storage and spill detection
In some systems, liquid management components are contained in a liquid 
cabinet below the system deck. In addition, a spill detection sensor installed in 
the cabinet can be configured to display spill notifications or pause a protocol 
when spills are detected.

IMPORTANT The spill- detection sensor is not a safety device. The sensor 
alerts you in case of spills in the system to prevent loss of materials and allow 
timely cleanup. It cannot distinguish between different types of chemicals used, 
and it does not warn you of hazardous conditions.

CAUTION The liquid cabinet is not intended to be a storage cabinet and is not designed to 
comply with NFPA Code 30 or similar regulations. Do not store explosive, flammable, 
combustible, or corrosive chemicals in the liquid cabinet.
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For detailed information about the liquid cabinet and the spill detection 
sensor, see the BioCel System User Guide.

High-pressure gas 

Compressed air is used to move components within some devices that can be 
integrated with the BioCel System, such as the following:

• Vertical Pipetting Station shelves

• PlateLoc Sealer

• Seal Piercer

• Microplate Labeler

Follow the local, state, and federal safety codes for the placement and 
mounting of gas cylinders. For example, you might have to attach a standard 
cylinder bracket to a solid permanent structure to meet or exceed all local 
seismic and safety requirements.

Always use good laboratory practices when handling high- pressure cylinders. 
Make sure you follow any instructions provided with the cylinders.

 

Nitrogen gas (Inert Environment Hood only)

The BioCel System Inert Environment Hood uses nitrogen gas to displace air in 
the system enclosure. Under normal operating conditions you are protected 
from hazardous exposure to the gas. However, you must be aware of the 
hazards and how to avoid them.

Use nitrogen only in a well- ventilated lab area. Turn off the nitrogen source 
when the BioCel System is not in use.
                                                        

WARNING  Working with open, charged air lines can result in injury. Turn off the 
compressed air line when disconnecting or reconnecting devices that use compressed air. 
Contact your facilities department or Automation Solutions Technical Support with 
questions about setting up the air line.

WARNING Nitrogen is an odorless, colorless, and nontoxic gas that can cause rapid 
suffocation by displacing air. Use nitrogen only in a well- ventilated lab area. Turn off the 
nitrogen source when the BioCel System is not in use.
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The following safety label is placed in the BioCel System to warn you to 
consult the accompanying user documentation for important safety information, 
including low- oxygen hazards.

Oxygen monitors
Two oxygen monitors are provided with the system to prevent accidental 
suffocation: one on the inside of the system, and one on the outside of the 
system. The oxygen monitors sense and display the percentage of oxygen 
present. 

Figure Example of an oxygen monitor

To prevent accidental suffocation:
• The internal monitor interacts with the safety interlock system so that 

when the system chamber contains less than 19.5% oxygen, the doors lock 
automatically. To open the doors, the system requires that you first purge 
the nitrogen gas.

• The external monitor interacts with the safety interlock system so that 
when the air surrounding the BioCel System contains less than 19.5% 
oxygen, the shutoff valves cut off the gas supply to the BioCel System.

Door locks and safety interlock system

The BioCel System has a door- locking and safety interlock system that 
prevents you from opening the doors and being exposed to high levels of 
nitrogen gas. When you turn on the gas at the system Environmental Controls 
panel, the system doors lock automatically. To unlock the doors, you must first 
purge the nitrogen from the enclosure.
                                                        

WARNING To prevent accidental suffocation, do not remove the provided oxygen 
monitors. 

WARNING Do not disable or defeat the door locks or interlocks. 
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Argon gas (Gas-Purging PlateLoc Sealer only)

The Gas- Purging PlateLoc Sealer uses argon gas to displace air in the sealing 
chamber before sealing a microplate. For safety reasons, the Gas- Purging 
PlateLoc Sealer automatically turns off the argon inside the device immediately 
before the seal is applied. Under normal operating conditions you are protected 
from hazardous exposure to the gas. However, you must be aware of the 
potential hazards and how to avoid them.

Make sure to turn off the argon source when the Gas- Purging PlateLoc Sealer 
is not in use.

Heat hazards

PlateLoc Sealer

The PlateLoc Sealer uses a heated metal plate inside the sealing chamber 
during the sealing process. A warning label on the front panel warns you of 
the potential burn hazard. The following figure shows the location of the label.

Figure PlateLoc Sealer heat hazard warning label

WARNING Argon is an odorless, colorless, and nontoxic gas that can cause rapid 
suffocation by displacing air. Use argon gas only in a well-ventilated lab area. Install an 
oxygen monitor in the lab area so that an alarm that will sound if the oxygen level falls 
below the acceptable threshold. 

WARNING Burn hazard. 
Hot surface inside. Allow to 
cool before servicing.

WARNING Do not touch the PlateLoc Sealer or pry open the door while it is in 
operation. The hot surfaces can cause burn injury. Allow the device to cool before 
servicing.
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Microplate Labeler

WARNING The printer can become hot while printing. Do not touch the printer 
components during operation. Allow the printer to cool down before changing the media or 
cleaning the printer components.
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